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Purpose of this document 

This document describes the functionality and intended usage of MacroView 
ClauseBank. It is also a guide for Administrators responsible for the 
maintenance of MacroView ClauseBank. 

Legal Notice 

MacroView ClauseBank and components are produced and licensed by 

MacroView Business Technology Pty Limited (MacroView).  

This guide contains material that is copyright to MacroView. It should not be 
copied or otherwise reproduced without express permission from MacroView. 

Disclaimer 

Every precaution has been taken in the preparation of this documentation 
however MacroView assumes no responsibility for errors or omissions, or for 
damages resulting from the use of the information contained herein. 

Trademarks 

MacroView and MacroView ClauseBank are registered trademarks of 
MacroView Business Technology Pty Limited in Australia, USA, Canada and all 
countries that are signatories to the Madrid convention. 

Microsoft, Microsoft Office, Microsoft PowerPoint, Microsoft Word, Microsoft 
Outlook and Microsoft SharePoint are all trademarks of Microsoft Corporation. 

Copyright 

© 2004-2016 MacroView Business Technology Pty Limited. 
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1 Introduction 

MacroView ClauseBank makes it easy to publish, retrieve and insert frequently 
needed standard text and graphics into your Word documents, Outlook 
messages and PowerPoint presentations. Whether you generate sales 
proposals, financial plans, legal documents or general correspondence, 
ClauseBank makes Word, Outlook and PowerPoint more productive. 

All organisations have standard text and graphics that are frequently required 
for inclusion in documents being generated. With MacroView ClauseBank, this 
material is published in a convenient central SharePoint website. This site can 
be accessed over any internet connection, which means that all staff, 
regardless of their location, can have convenient and immediate access to the 
latest standard material.  

MacroView ClauseBank ensures that only up to date material is retrieved from 
this central SharePoint website. The automatic Expiry Alert1 feature of 
MacroView ClauseBank assists in maintaining the content so that it is up to 

date. 

MacroView ClauseBank eliminates the time wasted in searching for material in 
previously generated documents and the risk of using an out-of-date copy. 

Clauses can contain MacroView Precedent mark-up tags and can be used in 
conjunction with MacroView Precedent. 

MacroView ClauseBank is the result of MacroView’s extensive experience with 
the development of custom document automation solutions for some of 
Australia’s leading banks, law firms and many other organisations. This is 
combined with leading technical skills in Microsoft Office and Microsoft 
SharePoint.  

                                                      
1 MacroView ClauseBank Expiry Alert feature is only available for on-premises SharePoint servers 
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2 Where does ClauseBank surface? 

MacroView ClauseBank can be installed in Office 2007, 2010 and 2013. 

If the MacroView ClauseBank facility has been installed, the MacroView 
ClauseBank tab is available on the Insert tab of the Ribbon in your Word, 
PowerPoint and Outlook environments. There is also a ClauseBank tab on the 
Home tab on the Ribbon. 

Note: Before you can use ClauseBank you must first have one or more 
ClauseBank content sources configured.  Refer to section 9.1.2 for 
information on adding, editing and removing content sources. 

2.1 Word 

MacroView ClauseBank adds a ClauseBank group to both the Home and Insert 
tabs on the Word Ribbon. On the Home tab the buttons include: 

 Insert Clause – allows you to insert clauses at the current cursor position in 
the active document 

 Insert ClauseLink – allows you to insert ClauseLinks at the current cursor 
position in the active document 

 New Clause2 – allows you to create a new clause by selecting text in the 
current document 

 Expand – replaces all ClauseLinks in the active document with the actual 
clauses 

 Options - allows you to configure your ClauseBank. 

 

Figure 1: The MacroView ClauseBank button on the Home tab in Microsoft Word 2013 

Only the Insert Clause and Insert ClauseLink buttons are available on the Insert 

tab. 

 

Figure 2: The MacroView ClauseBank buttons on the Insert tab in Microsoft Word 2013 

If there is no document open in Word the following message will display if you 
click on the Insert Clause, Insert ClauseLink or Expand buttons. 

 

Figure 3: The MacroView ClauseBank message that displays when no document is open 

The New Clause button is greyed out until you select text. 

Note that when in Microsoft Word, you cannot insert Clauses/Slides created in 
Microsoft PowerPoint. 

                                                      
2 New Clause functionality is not available with SharePoint 2007 (MOSS). 
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2.2 PowerPoint 

MacroView ClauseBank adds a ClauseBank group to both the Home and Insert 
tabs on the PowerPoint Ribbon. On the Home tab the buttons include: 

 Insert Clause – allows you to insert clauses at the current cursor position in 
the active presentation 

 New Clause3 – allows you to create a new clause by selecting text and 
graphics in the current presentation 

 Options - allows you to configure your ClauseBank. 

 

Figure 4: The MacroView Insert Clause, New Clause and Options buttons on the Home tab in Microsoft 
PowerPoint 2013 

Only the Insert Clause button is available on the Insert tab. 

 

Figure 5: The MacroView Insert Clause button on the Insert tab in Microsoft PowerPoint 2013 

If there is no presentation open in PowerPoint the following message will 
display if you click on the Insert Clause button. 

 

Figure 6: The MacroView ClauseBank message that displays when no presentation is open 

Note that when in Microsoft PowerPoint you can also select Document Libraries 
with “Slides” in the name. 

2.3 Outlook 

MacroView ClauseBank adds a ClauseBank group to both the Message and 
Insert tabs on the Outlook Ribbon. On the Message tab the buttons include: 

 Insert Clause – allows you to insert clauses at the current cursor position in 
the active email message 

 Options - allows you to configure your ClauseBank. 

 

Figure 7: The MacroView Insert Clause and Options buttons on the Message tab in Microsoft Outlook 2013 

Only the Insert Clause button is available on the Insert tab. 

 
Figure 8: The MacroView Insert Clause button on the Insert tab in Microsoft Outlook 2013 

                                                      
3 New Clause functionality is not available with SharePoint 2007 (MOSS). 
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3 Insert Clause 

When you click on the button to insert a clause, the MacroView ClauseBank 
screen displays. This screen is populated by retrieving clauses from a central 
SharePoint site (the ClauseBank site). Clauses are organised into Libraries and 
within each library by Category or into Folders4. 

Using the MacroView ClauseBank screen, you can preview any clause and 
select either a single clause or a number of clauses for insertion into the current 
Word document, Outlook message or PowerPoint presentation. 

MacroView ClauseBank automatically remembers your most recently selected 
ClauseBank Library the next time that you use MacroView ClauseBank. 

3.1 Display mode 

This screen displays a tree-view showing all the ClauseBanks that you have 
permission to access - potentially on multiple SharePoint servers. This was 
previously known as the Browse Tree-View mode. 

Note that the Details mode has been deprecated. 

3.2 Selecting a Clause Library 

The tree-view also depicts the Clause Libraries available in each ClauseBank 
site and the Categories or Folders in each Clause Library. 

 

Figure 9: The MacroView ClauseBank screen displaying the tree-view. 

The first time you use MacroView ClauseBank you will be see a tree-view of the 
ClauseBank sites for which you have that you have permission to access. 

Only those sites whose names contain the word ClauseBank in the SharePoint 
site name will be displayed. 

Using the MacroView Options the sites can be allocated a business user 
friendly name that does not have to include the word “ClauseBank” (Figure 10). 

                                                      
4 Folder navigation is not available with SharePoint 2007 (MOSS). 
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Figure 10: When you first use ClauseBank you see the tree-view of ClauseBanks available to you 

Click the arrow to expand the ClauseBank site node. MacroView will then 
display the ClauseBank libraries that you have permission to access within that 
site. Only those document libraries whose names end in Clauses (and also 
Slides in PowerPoint), will be displayed (Figure 11). 

 

Figure 11: Clause Libraries in MacroView Demonstration site 

Click the arrow sign to expand the ClauseBank library node. MacroView will 

then display the ClauseBank categories within that library (Figure 12). 
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Figure 12: Categories in ‘Letter Clauses’ library 

If you click on the Clause library rather than the arrow the library is highlighted 
causing all clauses in that library to appear in the Clauses list (Figure 13). 

 

Figure 13: Clauses in ‘Letter Clauses’ library 

If you double-click on the Clause library rather than the arrow the library is 
highlighted causing all the categories in that library to be displayed and all 
clauses in that library to appear in the Clauses list (Figure 14).  

Note that an All Categories option appears as the first category for all libraries 
so that all clauses available in the library can be viewed in one list. 
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Figure 14: All Categories option in Clause library. 

If you click on a particular category only the clauses in that category will display 
in the clause list (Figure 15). 

 

Figure 15: A selected category with clauses displayed. 
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3.3 Selecting a Clause Library and Folder 

3.4 Clauses List 

When you click on a Category, the valid clauses in that Category are displayed 
in the Clauses list. Valid clauses are those clauses that have not exceeded their 
Expiry Date.  

If there are no valid clauses for a particular Category and the option to Display 
Expired Clauses is not selected then the Category will appear in the list and will 
display No clauses to display in the clauses list. 

 If there are no valid clauses for any category the All Categories will display No 
clauses found… in the clauses list (Figure 16). 

 

Figure 16: The relationship between Categories and Clauses list 

If there are no clauses created for a particular Category then that Category will 
not appear in the list. 

3.5 Previewing a Clause 

You can preview clauses before selecting them to check that you are selecting 
the appropriate clause by using the Preview Pane or the Preview Window. 

Note that clicking a hyperlink contained in the preview text will not work if the 
selected clause is stored in the Clause Library as a Word document. 

3.5.1 Preview Pane 

When you click on a clause in the Clause list, the Preview pane shows a fully-
formatted display of the currently selected clause (Figure 17). Clicking on the 
Show Preview / Hide Preview toggles the pane open and closed. 

If the clause is longer than a page click the left and right arrows at the bottom of 
the Preview pane to page through the clause. 

Prev / Next page buttons 
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Figure 17: Multi-page clause displayed in Preview pane  

3.5.2 Preview Window 

Clicking the Preview Clause button will cause the preview to be displayed in a -
full-screen window (Figure 18). This is useful for reading through longer 
clauses.  

Note: ClauseBank does not ship with full-screen preview button visible. Toggle 
Allow full screen preview in Options, ClauseBank Options, General. 

If the clause is longer than a page click the left and right arrows at the bottom of 
the Preview window to page through the clause. 

 

Figure 18: Multi-page clause displayed in Preview window 

Clicking the Close cross at the top right of the window will close the Preview 
Clause window (Figure 19). 

Preview Clause button 

Prev /Next page buttons 
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Figure 19: MacroView ClauseBank with Preview window and Preview Pane closed 

3.6 Displaying the Clause Description 

When you click on a clause in the Clause list the Description pane displays 
any description text that has been created with the clause. This text is useful in 
assisting you to know when to use this particular clause. 

Clicking on the Show Description / Hide Description toggles the pane open 
and closed (Figure 20). 

 

Figure 20: Single-page clause displayed in Preview pane with description 
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3.7 Searching for Clauses in the Clauses List 

To restrict the list of clauses in the Clauses list, type text in the search box and 
then click the search button. You can filter clauses based on text found within 
the name of the clause or by text found in the content of the clause. 

3.7.1 Filter by ‘Name contains’ 

By default the search type is Name contains. Type part of the clause name in 
the filter box that appears above the list then click the Search button (Figure 
21). 

 

 

 

Figure 21: Only those Clauses whose names contain the characters ‘equities’ are listed 

ClauseBank will automatically restrict the list of Clauses to be only those whose 
names contain the characters that appear in the filter box. 

To clear the filter, click the Clear Search button. 

If the Capitalise filter argument setting is ticked, ClauseBank will display the 
filter characters in UPPER CASE within the names of the clauses in the 
Clauses list. See Section o  for more detail about this setting. 

Note: The Filter by ‘Name Contains’ is not available at the site level unless 
advanced search options are enabled. 

3.7.2 Filter by ‘Clause contains’ 

Although this is referred to as a filter it actually uses the SharePoint Search. 
The SharePoint Search must be configured and a crawl run before a search will 
be successful.  

Note that the Filter by Clause contains option is available if using Microsoft 
SharePoint Server 2010, SharePoint Foundation 2013, SharePoint Server 2013 
or SharePoint Online (Office 365). 

Select the filter type Clause contains. Type the text that you want to search for 
in the contents of the clause in the search box that appears above the list then 
click the Search button (Figure 22). 

 

 

 

Figure 22 Only those clauses that contain 'planning' in their body are listed 

 
 

Search button 

 
 

Clear Search button 
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ClauseBank will automatically restrict the list of Clauses to be only those whose 
content contains the characters that appear in the search box. 

To clear the filter, click the Clear Search button. 

3.7.3 Advanced Search options 

If you tick the Option, Advanced setting Display advanced search options you 
will be provided with the following dropdown list of filter options instead of the 
Name contains or Clause contains options. 

 

See section 9.1.3 for more detail on this setting. 

 

Figure 23 Advanced search options 

Phrases may only contain whole words. In the example below if the ‘s’ is left off 
‘fees’ no items are returned. (Figure 24). 
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Figure 24 Advanced search for the phrase ’entry fees’ 

If you are searching for Clause that contains at least one of these words then 
you enter the individual whole words separated by a space. The example below 
shows the clauses that contain the words ‘securities’ and/or investment’. (Figure 
24). 

 

 Figure 25 Advanced search for the words ‘securities’ and/or investment’ 

The results returned rely on the configuration of your SharePoint search. 
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3.8 Selecting Clauses to Insert 

You can select the clauses and move them into the Selected Clauses list. You 
can choose a combination of clauses from various libraries and categories if 
you so desire. To move clauses into the Selected Clauses list you can: 

 drag and drop the clauses 

 double click on the clauses 

 click the move button 

 right click and choose Add to Selected Clauses (Figure 25). 

 

Figure 26: Insert clauses using Add to Selected Clauses  

If Allow duplicate clauses is ticked in Options, General tab, you will be able to 
select and move each clause into the Selected Clauses list multiple times. 
(Figure 27) See Section o Error! Reference source not found. for more 

details of this setting. 

 

 Figure 27: Multiple copies of the clauses can be selected. 

 
 

Move button 
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3.9 De-Selecting Clauses 

To remove a clause from the Selected Clauses list, click to select the clause in 
your Selected Clauses list then click the Remove Clause button (Figure 28 

and Figure 29). 

 

Figure 28: Before clicking the Remove Clause button. 

 

Figure 29: After clicking the Remove Clause button the clause no longer appears in the Selected Clauses 
list. 

  

Remove clause 

button 
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3.10 Changing the Order in which Clauses will be Inserted 

Clauses will be inserted into your document in the order in which they appear in 
the Selected Clauses list. To change the order of clauses in the Selected 
Clauses list you can drag and drop the clauses to move them up and down the 
list or click on a clause in that list and click the Move clause up or Move 
clause down buttons until the clauses are in the order that you require (Figure 
30). 

 

 

Figure 30: Adjusting the ordering of your Selected Clauses list 

  

 
Move clause up 

Move clause down 
buttons 
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3.11 Inserting Clauses 

When you have selected and ordered the clauses that you want to insert, click 
the OK button (Figure 31). 

  

Figure 31: Clicking the OK button will insert selected clauses into your document. 

Alternatively if you tick the Option, Advanced setting Allow clause to insert on 
right click you can select the clauses in the clause list and right click then 
choose Insert to have them placed in the current document without moving 
them into the selected clauses panel. See Section 9.1.3 for more detail on this 
setting. 

 

Figure 32: Right click Insert will insert selected clauses into your document. 
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4 Insert ClauseLink 

When you click on the Insert ClauseLink button, the MacroView ClauseBank 
screen displays. The functionality of this screen is as described in section 3 
above. When you click OK, instead of inserting the clauses in the clause list, 

links to each of the clauses are inserted in the document (Figure 33). 

 

Figure 33: Inserted ClauseLinks 

 

Clause Link: Business Day 

Clause Link: Company 

 

The advantage of inserting ClauseLinks in certain documents rather than 
inserting actual clauses is that the clauses can be expanded when the 
document is being prepared to issue guaranteeing that the latest version of the 
clause is included. This is important for clauses that may update regularly with 
legal or fee information for instance. 

You can also include ClauseLinks within other clauses. 

Note that ClauseLinks are only available in Microsoft Word. 

https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
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5 Expanding ClauseLinks 

There are two ways to expand ClauseLinks – the Expand ClauseLinks tick box 
on the Insert Clause dialog or using the Expand button on the ribbon. 

5.1 Expand ClauseLinks tick box 

If a clause contains ClauseLinks the ClauseLinks will not expand when you 
insert the clause unless you tick the Expand ClauseLinks box. If you tick this 
box the ClauseLinks within the clause are expanded immediately after the 
clause is inserted. (Figure 34). 

 

Figure 34: Inserted ClauseLinks 

 
THE PARTIES AGREE that: 

Definitions 

In this Deed, unless the context requires otherwise: 

 "Business Day" means a day, other than a Saturday or Sunday, on which 
banks are open in Hong Kong to the general public for business; 

 "Company" means [●] a company under the laws of [●], particulars of which 

are set out in Schedule 1; 

 

 

5.2 Expand button 

When you click on the Expand button, every ClauseLink in the document will be 
replaced by the latest version of appropriate clause stored in the Clause library. 

You will be prompted to confirm that you want to expand all ClauseLinks in the 
document (Figure 35 and Figure 36). 
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Figure 35: Dialog to confirm expansion of all ClauseLinks in the document 

 

Clause Link: Business Day 

Clause Link: Company 

 

 

"Business Day" means a day, other than a Saturday or Sunday, on which 

banks are open in Hong Kong to the general public for business; 

"Company" means [●] a company under the laws of [●], particulars of which 
are set out in Schedule 1; 

Figure 36: Expanded ClauseLinks 

https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
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6 Right click menus on the Tree-view nodes 

6.1 Refresh 

Refresh updates the current node of the tree and everything below. So for 
example if you have selected a server node, Refresh updates all ClauseBanks, 
libraries, categories and clauses on that server. If you have selected a library 
node Refresh updates all categories and clauses in that library. 

The Refresh option appears when you right click a site, library or folder. You 
can also select a site library or folder and press F5 to refresh. 

6.2 Open in browser 

MacroView ClauseBank allows quick and easy access to the SharePoint sites 
and libraries that contain the clauses (Figure 37). 

If the Options, General, Allow open in browser is ticked the Open in browser 
option appears in the menu when you right click a site or a library. See Section 

o  for more details of this setting. 

If you click the Open in browser option the selected site or library will be 
opened in SharePoint. 

 

Figure 37 Open in browser and Refresh from site node 

6.3 Create ClauseBook 

The ClauseBook function writes the content and information about all the 
clauses in a selected Clause Library into the current Word document at the 
cursor position. 

This Word document can be based on a template that controls the layout of 
ClauseBooks so that the text complies with the formatting requirements of your 
organisation. This functionality is particularly useful for Content Managers and 
ClauseBank administrators for reviewing their ClauseBanks. 

If the Options, General, Enable ClauseBook is ticked the Create ClauseBook 
option appears in the menu when you right click a library. See Section o  
for more details of this setting. 

To create a ClauseBook for a Clause Library, select the library then right click 
and choose Create ClauseBook (Figure 38). 
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Figure 38: Create ClauseBook option. 

The ClauseBook will start with the Library name, Library URL and the date. This 
is followed by the clause name, clause category, description and clause content 
for each clause in alphabetic order. See sample ClauseBook in Figure 39. 

 

Figure 39: A ClauseBook for the Definition Clauses library 

If the Options, Advanced, Enable modeless insert window is ticked the 
ClauseBank dialog won’t close after creating a ClauseBook. If it is not ticked the 
ClauseBank will close automatically after creating the ClauseBook. See Section 
9.1.3 for more details of this setting. 
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7 Creating new clauses 

The New Clause button appears on the ribbon in Word and PowerPoint if 
enabled in Options, General, Enable New Clause button. If this option is not 

enabled or the version of SharePoint in use is 2007, the button is not available. 

7.1 In Word 

If you have text in a Word document that you would like to add as a clause 
select the clause and choose the New Clause button on the ribbon. 

 

Figure 40: Create New Clause 

Type a name for the clause and select the appropriate folder or library in the 
tree view in the Create New Clause dialog then click Save. 

 

Figure 41: Save the new clause 
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You will then be prompted to enter the metadata for that clause and then click 
OK. 

 

Figure 42: Enter the metadata for the new clause 

Once you refresh the ClauseBank site, library or folder the new clause will be 
visible. 

 

Figure 43: New GST Clause available in a subfolder of the ClauseBank 



   
MacroView ClauseBank v8.3 User Guide 

 

Effective: January 2017  25 

7.2 In PowerPoint 

If you have content in a PowerPoint presentation that you would like to add as a 
clause select the content and choose the New Clause button on the ribbon. 

 

Figure 44: Create New Clause 

Type a name for the clause and select the appropriate folder or library in the 
tree view in the Create New Clause dialog then click Save.  

You will then be prompted to enter the metadata for that clause and then click 
OK. 

Note that you are not prompted for a Content expert in PowerPoint 

 

Figure 45: Enter the metadata for the new clause 

Once you refresh the ClauseBank site, library or folder the new clause will be 
visible. 
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Figure 46: New Fifa 2014 Clause available in the ClauseBank 

Note that you can create a clause containing multiple slides. 
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8 MacroView ClauseBank Agent 

The ClauseBank Agent provides one-way clause synchronization from 
SharePoint to the user’s local computer profile so that ClauseBank can source 
content locally for previews, clause insertion and expansion.  ClauseLinks for 
which content exists locally can also be expanded even when offline. 

This feature of ClauseBank is particularly useful for deployments that are 
geographically diverse and have limited available bandwidth. 

After installing ClauseBank the MacroView ClauseBank Agent system tray 
application will start automatically. Please note the pre-requisites required in the 
Installation Guide.   

8.1 Adding libraries for synchronization 

In order to have libraries automatically added to the ClauseBank Agent, the Add 
libraries to ClauseBank Agent setting in the ClauseBank Content Source dialog 

must be enabled: 

 
Figure 47: ClauseBank Content Source dialog 

Note: After enabling the Add libraries to ClauseBank Agent option, a refresh of 
the source node is required before libraries will commence being added to the 
ClauseBank Agent. 

 

Figure 48: Refresh option on a ClauseBank Source 
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8.2 Managing Content Synchronization 

When the Add libraries to ClauseBank Agent setting is enabled, expanding sites 
in the ClauseBank tree-view will add discovered libraries to the ClauseBank 
Agent. 

The ClauseBank Agent is responsible for managing content sync as well as 
serving local replica content to the ClauseBank Client. The ClauseBank Agent 
process is a per-user single instance application that appears in the system tray 
using this icon. 

When you right-click on the ClauseBank Agent system tray iocn, you are 
presented with the following context menu: 

 

 
Figure 49: ClauseBank Agent system tray menu 

This menu provides access to the following functionality: 

 Manage Content Sync – displays the content synchronization 
management dialog 

 Settings – displays the MacroView ClauseBank Agent options 

 Sync Now – starts the synchronization process 

 Cancel Sync – cancels any currently active synchronizations 

 Exit – Exits the MacroView ClauseBank Agent 

 

The Manage Content Sync dialog provides access to libraries that are enabled 
for Content Sync to view their current status as well as the status of their most 
recent synchronization and allows you to work with each synchronisation via a 
right click context menu.  

 

 
Figure 50: ClauseBank Agent Manage Content Sync window 
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The options available on the context menu for each synchronization item are: 

 Open – opens the selected library in the web browser 

 Sync Now – queues the selected libraries for immediate 
synchronization 

 Cancel Sync – cancels synchronization and removes the selected 
libraries from the sync queue 

 Exclude/Include – deletes existing synchronization data for the 
selected libraries and prevents future synchronization from occurring or 
re-enable synchronization of the library 

 Remove – deletes existing synchronization data for the selected 
libraries and completely removes them from the ClauseBank Agent 

 

8.3 Troubleshooting Synchronization 

 

This button at the top right of the Manage Content Sync window opens the trace 
files folder. 

All ClauseBank Agent data is stored at: 

%LocalAppData%\MacroView\ClauseBank\Agent.  

Trace files are store under the Trace sub folder and are split into two files: 

 AgentTrace – contains tracing information for the agent itself 

 SyncTrace – contains tracing information for synchronization sessions 

initiated by the agent 

8.4 Configuring the Agent 

The Agent tab on the ClauseBank Options dialog provide access to ClauseBank 
Agent settings.  Refer to section 9.1.4  

When accessing this Options dialog via the Settings option on the ClauseBank 
Agent system tray context menu General and Advanced tabs are unavailable.  

8.5 Limitations of the ClauseBank Agent 

 The ClauseBank Agent supports SharePoint 2010, 2013 and 
SharePoint Online 

 You must have the Background Intelligent Transfer Service enabled in 
Windows (default Windows behaviour) and install all pre-requisites 

 You must use Windows authentication for on-premises servers 

 Cross-domain authentication scenarios are not supported 

 Some deeply-nested library structures may fail to sync if the total path 
length exceeds the Windows filesystem limit 
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9 Options 

If you click the Options dropdown the ClauseBank Options and About options 

appear. If you click the Options button the ClauseBank Options dialog displays. 
(Figure 51). 

9.1 ClauseBank Options 

Settings in the ClauseBank Options dialog are implemented through user-based 
registry settings but can also be set and locked by IT administrators using 
Group Policy. 

The ClauseBank Options dialog consists of three tabs: 

 General 

 Content  

 Advanced 

 Agent 

When accessing the dialog from the system tray context menu the General and 
Advanced tabs are unavailable. The Agent has a trace level setting independent 
of the ClauseBank Client as synchronization scheduling and operations 
generate large amounts of tracing when the Information level is selected. 

9.1.1 General 

  

Figure 51: The General tab within ClauseBank Options 

Enable ClauseBook 

When ClauseBook functionality is enabled, an additional Create ClauseBook 
option is available in the right click menu of the tree when you select a library. 
When this option is clicked, ClauseBank creates a listing of Clause information 
and content from the current Clause library (6.3 above). This functionality is 
particularly useful for Content Managers and ClauseBank administrators. 
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Allow open in browser 

Enabling this option allows you to jump to the current SharePoint site, library or 
folder in your web browser where you may edit content if you have the 
appropriate permissions. Some organisations may prefer that you don't access 
SharePoint directly and will choose to disable this option. 

Allow duplicate clauses 

When this option is enabled, you are able to insert multiple copies of the same 
clause into a document at the same time. This is convenient for documents that 
contain multiple signature blocks for instance. 

  

Figure 52: Allow duplicate clauses. 

Display ‘No Category’ category 

Adds the ‘No Category’ to each library in the tree. When you select No Category 

displays any clauses in that library that do not have a value category assigned. 

 

Figure 53: The Business Set clause is not assigned to a category. 
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Capitalise filter argument 

If this option is enabled the Name contains filter argument (text) that you enter 
will be highlighted in each of the clause names that are returned in the filtered 
list by rendering it in uppercase (Figure 54). 

 

Figure 54: Name contains filter showing capitalisation 

Show expired clauses 

When this option is enabled, clauses which have expired are shown with a line 

through the name and the icon following them. See the example below. 
(Figure 55). Though these files can be previewed you cannot select and insert 
these clauses. If this option is disabled expired clauses will not appear in the 
clause lists. 

 

Figure 55: Expired clauses have asterisks on each side of the clause name. 
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Display view toggle buttons 

Enabling this setting will show or hide the Hide Preview and Show Description 
buttons on the ClauseBank dialog. Refer the screenshots below. (Figure 56 and 
Figure 57) 

 

Figure 56: Displaying the view toggle buttons. 

 

Figure 57: Not displaying the view toggle buttons. 
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Allow full screen preview 

If a clause is selected and this setting is enabled a button appears on the 
ClauseBank dialog that when clicked allows users to view a full screen preview 
of the selected clause. Refer to the screenshot below. (Figure 58) 

 

Figure 58: Displaying the view toggle buttons. 

 

Figure 59: Multi-page clause displayed in Preview window 

Clicking the Close cross at the top right of the window will close the Preview 
Clause window (Figure 59). 

Download clauses for insert 

Enabling this option causes ClauseBank to use a web request to download the 
selected clauses to the temporary files path and then insert them into the 
document. By default, the Clause is downloaded to the Internet Explorer 
temporary files area and then inserted using a http call into the document. We 
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found that the performance was much improved when inserting a large number 
of small Clauses if this option was used. 

Apply design template to inserted slides 

Design templates can be applied to a PowerPoint presentation to give it a 
professional look. Enabling this setting will apply the design template used in 
the presentation to all slides that are to be inserted. 

Language 

ClauseBank now has support for a number of languages including English, 
French, Spanish, Dutch, German, Russian, Chinese - Simplified, Chinese - 
Traditional and Thai. Please contact MacroView if you would like ClauseBank in 
another language. 

Enable New Clause button 

Enabling this option allows you to use the New Clause button in Word and 
PowerPoint. If this option is not enabled the button remains greyed out even 
when you select the content in the current document, presentation or message. 

9.1.2 Content 

In the Content area of ClauseBank Options, you can add, edit or remove 

ClauseBank content resources.  

The servers will have been configured by an Administrator. Refer to the 
MacroView ClauseBank Installation Guide for more detail. 

  

Figure 60: The Content screen within ClauseBank Options. 
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When you click the Add button the Add new source dialog displays. 

 

Figure 61: The ClauseBank Add new source dialog. 

If you enter a server name and address and tick the Search for ClauseBank 
sites option, when you click OK ClauseBank will perform a search and will 
return all sites with 'ClauseBank' in the site title. If your ClauseBank source 
settings change, ClauseBank will refresh your ClauseBank tree-view and clear 
your ClauseBank tree-view cache. 

This works for all servers other than WSS 3.0 and Foundation 2010. 

To synchronize library content to your local computer, enable the Add libraries 
to ClauseBank Agent option.  Refer to section 8 for information on the 

ClauseBank Agent. 



   
MacroView ClauseBank v8.3 User Guide 

 

Effective: January 2017  37 

9.1.3 Advanced 

  

Figure 62: The Advanced screen within Options, ClauseBank Options, 

Logging 

Allows you to set the amount of information captured by the trace file 
ClauseBank performs its normal operations. If any exceptions occur these are 
logged in the same trace file. These trace files are vital for MacroView support 
staff to diagnose and resolve issues that may occur. 

Enable modeless insert window 

Enable Modeless insert window will prevent the ClauseBank window from 
closing when the ‘OK’ button is clicked. The document remains fully accessible 
whilst the ClauseBank window is displayed. Note that only one modeless 
ClauseBank window can be shown per Office application. For example, if you 
are working with multiple Word documents, the modeless window is parented to 
the document that was active when ‘Insert Clause was clicked. 

Allow clause insert on right click 

If the Allow clause insert on right-click option is ticked an Insert option is added 
to the right click menu when you select a clause in the middle List Box. This 
option can be used with or without the modeless insert window. If the window is 
not modeless it will close after you click Insert. (Figure 63) 
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Figure 63: Right click Insert available for clauses 

Display advanced search options 

If you tick the Option, Advanced setting Display advanced search options you 
will be provided with the following dropdown list of filter options instead of the 
standard Name contains or Clause contains options. 

 

 

Figure 64 Advanced search options when enabled in Advanced Settings 

For a successful search you cannot enter wild characters or parts of words. 

All advanced search options utilize the SharePoint search service. No client-
side filtering occurs when advanced search options are enabled. 
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Display preview 

Toggles the preview panel on and off on the ClauseBank dialog. (Figure 64) 

 

Figure 65 Preview and description panels off 

Display description 

Toggles the description panel on and off on the ClauseBank dialog. (Figure 64) 

URL’s that contain http or https and email address are selectable in the panel 

 

Display clause URL tooltips 

If ticked when you hover over a clause you will see the URL path for that 
clause. 

Show clause selection buttons 

Toggles the display of the buttons used to move clauses to the third panel, 
buttons used to rearrange the clauses in the third panel and the button used to 
delete a clause from the third panel. 
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Figure 66 Clause selection buttons off 

Enable clause search on sites 

If you tick the Option, Advanced setting Enable clause search on sites you can 
enter search criteria into the search panel when you have the ClauseBank site 
selected and search the contents of that entire site. If this option is not enabled 
you can only search within the selected library. 

Show clause icons 

Toggle the display of Office application icons in the selection list 

9.1.4 Agent 

The ClauseBank Options dialog contains a tab for Agent settings: 

 
Figure 67: The Agent screen within Options, ClauseBank Options, 
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Trace Level 

This setting determines the amount of detail in the Agent and Sync trace files 

The Agent has a trace level setting independent of the ClauseBank Client as 
synchronization scheduling and operations generate large amounts of tracing 
when the Information level is selected. See section 9.1.4 for more details.  

Sync Interval  

This setting determines the interval at which library synchronization occurs. The 
input box format is Hours:Minutes:Seconds 

Maximum Libraries to Sync Simultaneously 

This setting determines the number of libraries that can be synced in parallel by 
the ClauseBank Agent 

Sync Batch Size 

This setting limits the number of items to retrieve per request 

Automatically Sync New Libraries  

This setting determines whether new libraries added to the agent are included 
or excluded by default 

9.2 About 

 

Figure 68: The About screen within MacroView ClauseBank Options 

The About screen displays: 

  the current version of MacroView ClauseBank 

 copyright information 

 MacroView’s contact details 

 Trace Files button. When you click on the Trace Files button Windows 
Explorer opens the folder where the MacroView ClauseBank trace files are 
stored. This location varies between operating systems.  

Windows Vista, Windows 7 and Windows 8 

C:\Users\userid\AppData\Roaming\MacroView 

ClauseBank 

where userid is the current user login. 

 Clear Trace Files button. When you click on the Clear Trace Files button 
all MacroView ClauseBank trace files are deleted. 

 


